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PREFACE

Model Overview

LoadDynamicsTM is a load forecasting tool. The model provides proba-
bilistic information about future load conditions and thus aids the devel-
opment of local area investment strategies. The model was developed as
part of an EPRI project to produce area investment planning tools for
the electric power industry. Two factors motivated the development of the
LoadDynamicsTM approach for characterizing load uncertainty:

First, for distribution planning, a key issue is at what point in the
future will load growth result in a given level of demand. This de-
termines the time to the next investment decision, since distribution
capacity requirements are based on load levels. Thus, a complete de-
scription of potential load trajectories over time is required in order
to determine the time to the next decision.

Second, load growth follows trends. For example, area load typically
might grow at a low, steady rate for several years and then transition
to rapid growth for a time. This suggests that modeling future load
conditions should start with characterizing key parameters associated
with the possible trends — the average durations of the trends, and the
likelihoods of shifting among the trends.

Two types of load forecasts are allowed. The user can specify the number
of years for the forecast. In this case the model generates a probability
distribution on possible load levels for each year, p(load|year). For this
type of run, two graphical outputs can be produced: 1) a plot of the average
load versus forecast year, and an upper and lower bound on load versus
forecast year; 2) a plot of the cumulative probability of reaching a given
load versus the forecast year.

Alternatively, the user can specify the largest load level that is to be con-
sidered. The model is then run for enough years so that the cumulative
probability of reaching the specified maximum load is 1.0. This type of
model run generates probability distributions on the time to reach load,
p(time to load|load). This information is generated for all possible loads
from starting load to maximum load. For output, the full distributions are
converted to three-branch discrete distributions using a moment matching

v



technique. The technique creates three-branch discrete distributions that
have the same first five moments as the full distributions. The user can
examine selected three-branch distributions with a graphical output that is
built into the user interface.

Computer Implementation

The analytical engine for LoadDynamicsTM is written in C++. The inter-
face is written in Visual Basic. The model requires a small set of data that
is input via one input form. Graphical outputs capabilities are built into
the user interface.

Acknowledgments
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Peter Morris and Charles Feinstein formulated the load uncertainty model.
Steve Chapel, with help from Mukund Thapa, designed the computer im-
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TO REPORT PROBLEMS AND GET HELP RUNNING THE MODEL,
CONTACT EPRI USER SUPPORT:

The EPRI project manager
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1 INTRODUCTION

1.1 Installing the Model

The accompanying CD disk contains the setup program that will install
Version 2.0 of the model. The system requirements for the model are:

• Windows 95/98/NT,
• 32mb of RAM,
• 8mb of free space on a hard drive,
• Acrobat Reader 4.0 installed on the host machine.

Acrobat reader is used by the model to display the help file. If the user
does not have the software, it can downloaded for free from Adobe’s web
site (www.adobe.com).

To install LoadDynamicsTM you need to do the following. First, if you have
older version of the model installed on our computer, you will need to unin-
stall the program. You do this by selecting Start | Settings | Control Panel
| Add/Remove Programs | LoadDynamics | Add/Remove and then follow-
ing the directions that the uninstall program provides. You can then install
the new program by:

1. inserting the disk for Version 2.0 into your CD / DVD drive;

2. clicking on the Start button;

3. scrolling up and clicking on the Run button;

4. typing D:\Setup.exe (if D: is not the drive identifier for the CD
drive, enter the appropriate drive identifier); and

5. clicking the OK button. Follow the instructions as indicated during
the installation.

Note: for correct installation, turn off virus checking and disconnect your
computer from the network.

After you have followed these steps, you can upgrade the model to Version
2.1 by downloading the upgrade program from EPRI’s web site (www.EPRI.com)
and running the install program that is part of the upgrade package.
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Unless the user specifies otherwise during installation, the installation pro-
gram will create a subdirectory to your Program Files directory, will name
the subdirectory LoadDynamics. The model and its data files are placed
in this subdirectory. The DLL files are placed in the c:\windows\system
directory.

Note: Three example data sets are provided with the software. The in-
put files are corr_nocorr.ldp, assessor.drs, and assessor_jump.drs.
corr_nocorr.ldp is the input file used for the first tutorial, Section 3).

The user can uninstall the program by selecting “Start | Settings | Con-
trol Panel | Add/Remove Programs | LoadDynamics”.

1.2 Learning to Use the Model

LoadDynamicsTM is an easy model to use. We recommend the following
four steps as an efficient way to become familiar with (1) the mechanics
of running the model and (2) the methodology that underlies the model
calculations:

1. Review Section 2 to become familiar with the user interface, the input
data, and the outputs.

2. Do the first tutorial, Section 3, that uses the growth trend example
data set (corr_nocorr.ldp)

3. Do the second tutorial, Section 4, that uses the Load Assessor tool.

4. Read Section A that describes the analytical methodology.

1.3 Running the Model

While we do not recommend using the model to create load forecasts until
you have completed the tutorials in Sections 3 and 4, you can verify that
the model is installed and working by performing the following steps:

1. open the model by clicking START ,

2. select Programs,

3. highlight LoadDynamics and

2



Figure 1-1: Load Dynamics Main Screen After Opening a New Data File

4. click on the LoadDynamics icon.

5. use the File menu and click New to open a new data set.

Following these steps will result in the window shown by Figure 1-1. If it
does not you should contact EPRI for help. Assuming that the window is
displayed correctly, you should exit the program (select the File menu and
click Exit) and proceed to follow the steps outlined in Section 1.2 above.

1.4 Error Traps

The software traps most data inconsistencies at the user interface level.
However, there are certain situations where error conditions are recognized
only after the model is processing the data. In order to ensure robustness of
the software, the software traps run-time generated errors and reports them
back to the user in a Window as a RUN-TIME ERROR. When this happens
the user is asked to click OK, and the model returns to the main window.

In some (hopefully rare!) instances, the error message is one that should
not have occurred and occurs only because of an internal inconsistency in
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the software. In this case, Please contact EPRI User Support with the exact
message as it appears on your screen.

In other situations, the error message will point you in the right direction
and you can attempt to modify the data for the case and re-run the model.
However, in this case too, should the message be unclear or if you have any
questions, please do not hesitate to contact EPRI.

1.5 What’s New

Version 2.0 introduced several enhancements. These include:

• The Load Assessor tool was added to the model. This tool facilitates
development of the required load-growth input parameters. For a de-
scription see Section 2.3

• The speed of the load forecasting algorithm was increased dramatically.
• The user interface was improved.

The latest enhancements, Version 2.1, introduce the ability to model un-
certain block load increases (the potential for jumps in area load). Version
2.1 also fixes several small software problems. For a list of the latest pro-
gram changes see the installation instructions that accompany the upgrade
to Version 2.1.

1.6 Contacting EPRI User Support

TO REPORT PROBLEMS AND GET HELP RUNNING THE MODEL,
CONTACT EPRI USER SUPPORT:

The EPRI project manager
Steve Chapel
(650) 855-2608
schapel@epri.com
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2 USING THE MODEL USER INTERFACE

2.1 Overview

Figure 2-1 illustrates the steps necessary for running the model. After the
model is started a set of menus is available to the user (File, Edit, Run,
V iew Output, Plot, Help). These menus contain all of the commands for
running the model. Each menu is explained in Section 2.2. After starting
the program the user should use the menu commands to carry out the steps
shown in the diagram.

Start Program

Open File

(using file menu)

Select Forecast From Forecast Window
(double click on desired forecast)

© ©©H HH
HHH ©©©

Preserve Original Forecast Data

Copy Data To A New Forecast

(edit menu)

Edit Data
(input data form)

Run Model
(run menu)

View & Plot Results
(view menu, plot menu)

© ©©H HH
HHH ©©©

Done?

Save File &
Exit Program

?

?

?

?

?

?

?

?

?

If New

If Existing

¾

-No

Yes

-

No

Yes

Figure 2-1: Steps For Using LoadDynamicsTM
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2.2 Using the Menu Commands

When the model is started, a start-up window is displayed. This screen has
the name of the program, the version number, and the list of individuals
that developed the program. The user must click the OK button to close
the start-up screen.

Once the opening screen is closed, the main window for the program is
displayed. Using the main window menu system you can edit files, save
files, run the model and view results. The main screen with the file menu
open is shown below in Figure 2-2.

Figure 2-2: Main Screen With File Menu Open

2.2.1 The File Menu

The file menu is used to open new and existing input data sets and to save
input data sets. The file menu options are described next.

New Causes the program to clear all data and open a new set of data with
default values. If a case is being worked on, the user is given an option
to save the current data.
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Open Causes the program to prompt the user for an existing forecast file
through the standard Windows open dialog box. If a case is being
worked on, the user is given an option to save the current data.

Close Closes the forecast data file currently being worked on. The user is
given an option to save the current data.

Save Saves the forecast data to disk. If it is a new case the user is asked
to select a name and location through the standard Windows file save
dialog box.

Save As Saves the forecast data to disk under a user-specified name and lo-
cation. The user is asked to select a name and location through the
standard Windows file save dialog box.

Exit Exits the program. If the forecast data has changed and has not been
saved, the user is prompted and given the option to save the forecast
data.

2.2.2 The Edit Menu

The edit menu is used to create and edit forecast data sets. A single input
data file can contain data sets for many forecasts. Figure 2-3 shows the
main screen with the edit menu open, and with the two windows that are
used to create and edit forecast data sets.

When a new or existing file is opened, the window on the right is opened.
It contains the list of available forecast data sets that are associated with
the open input data file. By double clicking on a forecast in the window
on the right, the window on the left (the InputDataScreen) is opened and
loaded with the input variables for the selected forecast (When a new file
is opened one forecast data set is automatically created, labeled as “unti-
tled.001,” the InputDataScreen is opened, and the default data values are
shown). Figure 2-3 shows the situation in which a new file has been opened.

The edit menu is enabled only when a data file is open and the InputDataScreen
is active. The Edit menu options are described next.

Add Forecast Creates a new forecast data set with default values and loads the
default data values in the InputDataScreen.

Copy Forecast Opens a dialog box and asks the user for the name of the new forecast
data set. After the user supplies the name and clicks OK, the current
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Figure 2-3: Edit Menu

data loaded in the InputData Screen are copied to the new forecast
and the new forecast is loaded into the InputDataScreen.

Rename Forecast Opens a dialog box and asks the user for the new name. After the
user supplies the name, the selected forecast data set is renamed.

Delete Forecast: Removes the selected forecast from the forecasts in the current data
file and closes the InputDataScreen.

2.2.3 Input Data

LoadDynamicsTM requires a relatively small number of input variables. The
user must specify:

1. Type of forecast,

2. Initial system conditions (load level and annual growth rate),

3. Information on load growth trends (growth rates and transition prob-
abilities),

4. Load saturation parameters, and

8



5. Output parameters.

These data values are input using the InputDataScreen. With the excep-
tion of transition probabilities, developing the input variables is straightfor-
ward. Here we provide a brief description of the variables. Table 2-1 lists
the inputs, gives valid ranges of values, and provides a very brief explanation
for each.

Type of Forecast

Two types of load forecasts are allowed. The user can specify the number
of years for the forecast. In this case the model generates a probability
distribution on possible load levels for each year, p(load|year). For this type
of run, two graphical outputs can be produced: (1) a plot of the average load
versus forecast year, and an upper and lower bound on load versus forecast
year; (2) a plot of the cumulative probability of reaching a given load versus
the forecast year.

Alternatively the user can specify the largest load level that is to be con-
sidered. The model is then run for enough years so that the cumula-
tive probability of reaching the specified maximum load is 1.0. This type
of model run generates probability distributions on time to reach load,
p(time to load|load). This information is generated for all possible loads
from starting load to maximum load. For output, the full distributions are
converted to three-branch discrete distributions using a moment matching
technique. The technique creates three-branch discrete distributions that
have the same first five moments as the full distributions (mean, variance,
skewness, etc.).1 The user can examine selected three-branch distributions
with a graphical output that is built into the user interface.

Note: The drop-down menu for the type of forecast actually has four options.
There are the NumberofY ears and MaximumLoad options both without
Saturation. There are also these two options with Saturation.

1This is based on Gaussian quadrature. Miller A. and Rice T. 1983. Discrete Approx-
imations to Probability Distributions. Management Science, 29, 3, 352-362.
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Input Variable Explanation & Valid Range
Type of Forecast
1. Type of forecast Alternatives are: 1) No. years; 2) Max. load; 3) No.

years/with saturation; 4) Max. load w/saturation.
User selects from list in dialog box.

2. Number of years This is number of years for a “number of years forecast.”
0 < years ≤ 100

3. Maximum load This is maximum load for a “maximum load forecast.”
maximum load > initial load

Initial Conditions
1. Initial load Initial load is peak load at start of study.

initial load ≥ 0
2.Initial growth rate This is the growth rate at the start of the study.

initial growth rate ≥ growth rate of first trend
initial growth rate ≤ growth rate of last trend

Saturation Parameters
1. Saturation Load that saturates the area - maximum load possible.

saturation > initial load
2. Sat. Lower Bound Above this load, the saturation logic is applied.

0 < SLB ≤ (.95 saturation)
Load Growth Trends
1. No. of trends This is the number of growth rate trends.

User selects from the list.
2. Calc. Growth Rates The estimated growth rates associated with the trends.

This is not an input — it is calculated when the model is
run. See explanation in text.

3. Input Growth Rates The growth rates associated with the trends.
Ratei ≥ 0 and Ratei+1 > Ratei

4. Transition Prob. See explanation in text.
0 ≤ P (transition) ≤ 1.0

Outputs
1. Probability Bound For plotting bounds on load uncertainty (see explanation

in text).
0 ≤ Probability Bound < 0.5

2. Desc. of scenario A user specified label.

Table 2-1: Summary of Input Variables
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Saturation Parameters

Saturation and Saturation Lower Bound are simply defined. Saturation is
the maximum load that can occur in an area. As load approaches satura-
tion, one would expect that load growth would slow. For load levels below
“saturation lower bound” there is no slowing effect. This idea is handled in
the load model in the following manner. For load levels above the satura-
tion lower bound, the transition probabilities associated with positive load
growth states are reduced. The amount of reduction is controlled by an
attenuation factor. 2

Load Growth Trends

The model allows two to six load growth trends. Each growth trend has
an associated annual growth rate. Based on the load growth rates, the
forecasting algorithm calculates a base load growth rate and the closest
integer approximation associated with each rate. When the model is run, the
calculated estimates of growth trends are shown in the InputDataScreen.
Prior to running the model, the values are shown as N/A.

In the model, the load growth rates are defined as the base growth rate
raised to the integer exponent calculated for each user defined growth rate.
This provides for a very efficient calculation method.

Note: when two or more of the growth rates are very close numerically, the
model may generate the same integer exponent for the rates. This will result
in an error message and model termination. The occurrence of this error
depends on the range of growth rates relative to the closeness of individual
rates. When the range is wide and some rates are close, the error will occur.

Transition Probabilities

The rows in the trend transition matrix represent the trend at the beginning
of a year (row 1 represents trend 1, row 2 represents trend 2 and so on).
Each row contains a set of values. These values are probabilities of transition
from the original trend to a new trend. The diagonal elements are the
probabilities of remaining in the same trend. The off-diagonal elements are
the probabilities of shifting to new trends.

The question is, how does one come up with a reasonable set of transi-
tion probabilities? There are two alternatives: (1) use the LoadAssessor
add-in module, or (2) directly assess the load growth trends and transition
probabilities.

2The technical details for modeling load saturation are documented in project technical
papers. The interested reader can obtain these from the EPRI project manager.
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The LoadAssessor is activated by clicking the buttonASSESS LOAD GROWTH
PROBABILITIES. If the user clicks this button, the add-in assessment tool
is activated. This tool requires that the user answer a set of questions con-
cerning current load level and growth, and future load growth scenarios.
Based on the answers, the tool estimates the inputs for the growth trends
and transition probabilities. See Section 2.3 for a description of the Load
Assessor Model, including the input and output screens.

To assess the growth rates and transition probability inputs directly, the
user must:

• Select the set of annual growth rates that might be observed for the
forecast period,

• Assess the average amount of time that load tends to stay in each
trend,

• Assess the likelihood of shifting from one specific growth trend to
another specific growth trend.

This probability assessment procedure is sufficient because of two facts. First
the diagonal elements in the transition matrix are determined by the average
time that growth follows a specific rate before shifting. This is discussed in
Section A. The equation for average time in trend is:

Average T ime In State =
1

1− P (Staying in Same State)

Second the probabilities in any row must add to one. Thus, the assessment
procedure is the following:

1. Estimate the probabilities along the diagonal elements of the matrix
by assessing the average time in each growth state.

2. Estimate the off-diagonal elements of each row by assessing the rel-
ative likelihood of transition to one specific load growth state versus
transition to the other possible non-diagonal states, constraining the
row probabilities to add to one.
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2.2.4 Run Menu

Selecting the Run menu causes the model to make a forecast using the
data in the InputDataScreen. The results can then be examined with the
V iew output and Plot menus.

2.2.5 View Output and Plot Menus

Two types of load forecasts are allowed: a number of years forecast and a
time to load forecast. In the first, the user specifies the number of years for
the forecast and the model generates a probability distribution on possible
load levels for each year, p(load|year). For this type of forecast two graph-
ical outputs are available: (1) a plot of the mean load, and an upper and
lower bound on load versus the forecast year; (2) a plot of the cumulative
probability of reaching a given load level for each year of the forecast period.
For the second type of plot, the user selects the load levels to plot from a
dialog box.

Alternatively, the user can specify the largest load level that is to be con-
sidered. The model is then run for enough years so that the cumulative
probability of reaching the specified maximum load is 1.0. This type of
run generates a probability distribution on time to reach a given load,
p(time to load|load). This information is generated for all possible loads
from starting load to maximum load. For output, the full distributions are
converted to three-branch discrete distributions using a moment matching
technique. The technique matches the first five moments of the full distrib-
utions. The user can examine selected three branch trees with a graphical
output that is built into the user interface.

NOTE: LoadDynamics does not directly allow for printing of the tables and
graphic output. It does however allow the user to save the output data as
tab-limited text files. These files can be read both by word processors and
spreadsheet programs. The option to read saved output with spreadsheet pro-
grams facilitates further analysis and allows flexibility in creating graphics
and printing of both graphics and raw data.

The Y ear vs. Load and T ime toLoad tables, described below, have buttons
that allow the user to save forecast data.
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The V iew output menu items are described next.

Year vs. Load This output option is available if the user makes a number of years
forecast. Selecting this menu item displays a table that gives the
probability of being at specific load levels in any given year. Fig-
ure 2-4 shows the table that is generated. The user can save the data
as a text file by clicking the Save box on the form.

Figure 2-4: Example Output - Table of Probabilities: Year vs. Load

Time to Load This output option is available if the user makes a time to load fore-
cast. Selecting this menu item displays a table that give three-branch
probability distributions on the time it takes to reach specific load lev-
els. Figure 2-5 shows the table that is generated. The user can save
the data as a text file by clicking the save box on the form.
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Figure 2-5: Example Output - Table of Probabilities Time to Load
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The Plot menu items are described below.

Year vs. Load This output option is available if the user makes a number of years
forecast. Selecting this menu item displays a plot of the probability
of being at specific load levels in any given year. Figure 2-6 shows an
example of the plot that is generated.

Figure 2-6: Example Output - Plot of Probabilities: Year vs. Load

Cumulative Probability This output option is available if the user makes a number of years
forecast. Selecting this menu item opens a dialog box and the user
must selects one or more load levels for the plot. The model then
displays a plot of the cumulative probability of the time it requires to
reach that load level. Figure 2-7 shows an example of the plot that is
generated.

Time to Load This output option is available if the user makes a time to load forecast.
Selecting this menu item opens a dialog box and the user must select
a load level for the plot. The model then displays a plot of the three-
branch tree of the time it requires to reach that load level. Figure 2-8
shows an example of the plot that is generated.
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Figure 2-7: Example Output - Plot of Cumulative Probability of Reaching
a Specified Load by Year t

Figure 2-8: Example Output - Three-Branch Distribution on Time to Load
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2.2.6 Help Menu

The help menu items are described below.

Contents and Index If the user selects contents from the help menu, the contents of the
on-line manual are provided.

Disclaimer If disclaimer is selected, a window containing the EPRI legal disclaimer
is displayed.

About This provides copyright information and the version number of the
model
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2.3 Using the Load Assessor Tool

2.3.1 Introduction

Load Assessor estimates the load growth trends and the transition proba-
bilities required by the LoadDynamicsTM and Investment Strategy Models.
The estimating methodology requires data obtained from a set of questions
about future potential load conditions. The approach and questions were
developed in collaboration with utility distribution planners. The objective
was to base the methodology on a practical set of questions that the model
users can answer.

2.3.2 Using the Load Assessor User Interface

When the Load Assessor starts, the window below (Figure 2-9) replaces the
LoadDyanmicsTM main window. The user must then use the File Menu to
open a new or existing case. All Load Assessor files are of the form *.drs.
assessor.drs is the example case distributed with the software. Note that
the File menu also allows the user to save Load Assessor cases and to copy
Load Assessor results directly to the LoadDynamicsTM input screen, “Copy
Results to Growth Scenarios.”

Note: The data in the input screens shown here are for the data file asses-
sor.drs.

Home Screen

As soon as a case is opened, a series of steps are listed in the home window
along with the status of completion for each step (To Do, Done, Data Error,
Incomplete). Figure 2-10 shows the Home Screen for an existing case in
which all of the data have been input, and the model parameters estimated.
There are five steps in the assessment process:

1. Specify current load and growth

2. Specify load growth scenarios

3. Specify growth rate holding times

4. Specify maximum area load potential

5. Calculate load model parameters
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Figure 2-9: Load Assessor Main Screen

When a case is opened, new or existing, the status of data inputs are in-
dicated on the home screen. With a new case the user is constrained to
proceed through the assessment steps in sequence - the model will not allow
skipping a step, and valid data must be provided for each step before the
model will allow the user to go to the next step. The assessment software
performs error checking for each screen.

When the user is satisfied with the load assessor results he or she can (1)
save the results, and (2) copy the results to the LoadDynamicsTM model
input form. Copying the data to LoadDynamicsTM Model inputs can be
done via either the File menu or the button at the bottom of the home
screen.
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Figure 2-10: Load Assessor Home Screen
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Step1: Specifying Current Load and Growth

The data screen for assessment step 1, Specify Current Load and Growth,
is shown in Figure 2-11. Here the user must specify current area load and
load growth, and the time interval for the forecast assessment.

Figure 2-11: Current Load and Growth
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Step2: Specifying Load Growth Scenarios

The data screen for the second assessment step, Specify Load Growth Sce-
narios, is shown in Figure 2-12. The purpose of the second screen is to
describe potential future load growth scenarios. The basic idea is that the
user must specify a set of alternative growth conditions that could occur
over the planning period. Before filling in the data required by this form,
the user should read the instructions by pressing the Instructions button.

Figure 2-12: Load Growth Scenarios

The data inputs for the scenarios are described in Table 2-2:
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Input Explanation

Number of Scenarios The user must choose a number (2 to 5) from the drop-
down box.

Label A short label used to describe each scenario.

Description A longer, more descriptive characterization of each
scenario.

Average Growth
Rate Over Period
(%)

For each scenario, the user must specify the average growth
rate that is expected for the entire forecast period.

Lowest Growth Rate
In Any Year (%)

For each scenario, the user must specify the lowest growth
rate that can occur in any year for the forecast period.
This growth rate must be lower than the average growth
rate for the period.

Highest Growth
Rate In Any Year
(%)

For each scenario, the user must specify the highest growth
rate that can occur in any year for the forecast period. This
growth rate must be higher than the average rate for the
period.

Scenario Probability For each scenario, the user must specify the probability
that the scenario will occur. The probabilities for the sce-
narios must add to 1.0.

Is There a Possibility
For Periods of Rapid
Growth?

If there is a possibility of having short periods (one year
or less) of rapid growth, enter Y

Proportion of Future
Years With Rapid
Growth

If the user specifies Y to the question Is there a possibility
for periods of rapid growth, they must indicate the pro-
portion of future years where rapid growth is expected to
occur (0 to 0.2)

Annual Rate of
Growth For Rapid
Growth Years

If the user specifies Y to the question Is there a possibility
for periods of rapid growth, they must indicate the asso-
ciated annual percentage growth rate (this rate must be
at least twice as large as the highest rate entered in the
“highest growth rate in any year” column of the Scenario
Descriptions table.)

Table 2-2: Data Elements for Scenario Descriptions
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Step3: Specifying Growth Rate Holding Times

The data screen for the third assessment step, Specify Growth Rate Holding
Times, is shown in Figure 2-13. Before entering any data, the user should
click the Instructions button and get specific information about the data
inputs. This screen shows three one-year growth rates and the user must
supply average holding times for these rates. These rates come from user-
supplied inputs from the previous screens - the minimum and maximum
one-year rates from the scenario inputs, and the current growth rate from
the first input screen.

Figure 2-13: Growth Rate Holding Times
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Input Explanation

Average Years in the
Rate

This is what we have termed ”holding time.” Given that
load is growing at a rate, this is the time that load is
expected to continue to grow at that rate. This measures
the tendency for load to stay in a particular growth trend.

Load Transition Op-
tion

When load growth shifts from one trend to another, the
user must specify which of two conditions is more likely.
(1) A transition of one trend-step versus, (2), a transition
of two or more trend-steps. For example, is it more likely
that load will shift from a low rate to a medium rate or
from low to a high rate, bypassing the medium rate?

Table 2-3: Data Elements for Growth Rate Holding Times
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Step 4: Specifying Maximum Area Load Potential

The data screen for the fourth assessment step, Specify Maximum Area
Potential Load, is shown in Figure 2-14. Before entering any data, the user
should click the Instructions button and get specific information about the
data inputs.

Figure 2-14: Maximum Area Potential Load

Input Explanation

Maximum Attain-
able Area Load
(kW)

This is the load level when the area is completely built-
out. It is the level at which the area can absorb no further
growth.

Saturation Onset When saturation begins to occur, load growth begins to
slow. Saturation onset is the load level after which load
growth begins to taper-off.

Table 2-4: Data Elements for Maximum Area Load Potential
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Step 5a: Calculate Load Model Parameters

The data screen for the final assessment step, Calculate Load Model Pa-
rameters, is shown in Figure 2-15. This screen shows the results after the
Estimate Parameters button has been clicked.

Figure 2-15: Calculate Load Model Parameters

The functionality of the form for calculating the load model parameters is
summarized in Table 2-5 below:
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Button Explanation

Estimate Parame-
ters

If this button is clicked, the estimation model is run to
produce a new set of growth trends and transition prob-
abilities. If a new or modified data exist in any of the
screens, the transition matrix will not be shown until the
model is run.

Plot Results If this button is clicked, a plot of the probabilistic load
forecast is produced. This plot is shown in Figure 2-16
below.

Instructions This provides information on how the growth trends and
transition probabilities are estimated.

Table 2-5: Functionality of Calculate Model Parameters Form
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Step 5b: View Probabilistic Forecast

If the user clicks the Plot button in the Calculate Parameters screen, the
probabilistic forecast is plotted. This is shown in Figure 2-16. For each
year in the planning period, the maximum, minimum and average load are
plotted.

Figure 2-16: Plot of Probabilistic Forecast

If this load forecast does not accurately reflect the user’s assessment of the
possible loads for the area, the Options button should be clicked. Clicking
the Options button brings up a dialog box with the following information:

1. If the upper bound on load is too high (low), then you should try reduc-
ing (increasing) the average growth rate for the high growth scenario.
You can also change the maximum possible load level, saturation level.

2. If the lower bound on load is too low (high), then you should try
increasing (reducing) the average growth rate for the low growth sce-
nario.

3. If the expected value for load is too high (low) then you can reduce
(increase) the probabilities for the higher growth scenarios and / or
increase (decrease) the probabilities for the lower growth scenarios.
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You can also change the highest yearly growth rate for the high growth
scenario.

4. If load is growing too slowly (too rapidly), you should try increasing
(reducing) the highest yearly growth rate for the high growth scenario.

This completes Section 2, Using The Model User Interface.
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3 TUTORIAL 1: USINGGROWTH TREND EX-
AMPLE DATA SET

Two tutorials are provided. The first demonstrates how to read an existing
data set, run the model and view outputs. The second illustrates how to
use the Load Assessor tool to create a load forecast.

This tutorial has four steps:

1. Start the LoadDynamicsTM program and open an existing input file.

2. Select a forecast data set from the list of forecasts and run the model.

3. View plotted output data.

4. View a table of output and save the output data as a text file.

3.1 Step 1: Start Program and Open a Data File

For step 1 the user should:

• Open the model by clicking START ,

• Select Programs,

• Highlight LoadDyanamics and

• Click on the LoadDynamics icon and when the start-up screen is
displayed, click OK,

• Open the data set by selecting the File|Open menu and selecting
corr_nocorr.ldp and clicking Open.

The program will open the input file corr_nocorr.ldp and display the
forecast list. The program will also open the first load forecast in the forecast
list and display the input variables. This is show in Figure 3-1. Note that
at this point the Run menu is activated.
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Figure 3-1: Tutorial One: Result of Step 1

3.2 Step 2: Run The Model

Notice the values for the input variables. For this case the type of forecast
is Number of Y ears and the starting load and growth are 100MW and
1% respectively. Also note the values for the growth trends and transition
probabilities. The significance of these values are discussed in Section A,
Analytical Methodology. The purpose here is to demonstrate the mechanics
of using the model.

The user should click on the Run menu. This will run the model and show
a dialog box indicating that the model has run. The user should click the
OK box and proceed to the next step.

3.3 Step 3: View Plotted Output

Because this is a Number of Y ears forecast, the user has the option of
viewing plotted output for (1) the probability of being at a given load level
in any year, and (2) the cumulative probability distribution on the time it
takes to reach a given load level. We will now view both of these output
plots. To view the first graph the user should click on the Plot menu and
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Figure 3-2: Tutorial One: Result of Step 3a

select Y ear vs. Load. This will produce the graph shown by Figure 3-2. This
graph plots the average load growth over the period as well as the upper
and lower bounds on load for each year. When the user has finished viewing
the plot they can click Close to close the plot window.

To view the second plot, click on the Plot menu and select Cumulative
probability. This will bring up a dialog box where the user can select one or
more load levels. The user should select 105.10 and 120.81 and click Plot.
The program then produces the graph, shown by Figure 3-3. This graph
shows the cumulative probability distributions on the time it takes to reach
the load levels 105.10 and 120.81 respectively. When the user has finished
viewing the plot they can click Close to close the plot window.

3.4 Step 4: View Output Table and Save as Text File

The final step in this Tutorial is to view the output table and to save the
table as a text file. To do this select the V iew output menu and select
Y ear vs. Load. This will bring up the window shown in Figure 3-4. The
rows are the possible load levels. Columns define the years, 1 to 30 in this
case. The cells in the table give the probability of being at a specific load
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Figure 3-3: Tutorial One: Result of Step 3b

level in a specific year: p(loadi|yeart).
To save the data, click the Save button. This brings up a standard Windows
save dialog box asking for the name of the file where the data are to be saved.
The data are saved in a tab-limited format. The file can be read both by
spreadsheet and word processing programs.

To end this tutorial, click the Close button on the output table screen and
click the File|Exit menu.
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Figure 3-4: Tutorial One: Result of Step 4
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4 TUTORIAL 2: USING LOAD ASSESSOR TO
CREATE A PROBABILISITIC FORECAST

This Tutorial is based on a “real world” forecasting problem. The Tutorial
illustrates how the Load Assessor tool can be used to generate the inputs
required to make a probabilistic load forecast.

The forecast situation is the following: Blue Mountains Power Company
provides electric distribution service to a remote ski area. Presently there
is slow peak load growth (1/2 to 1 percent per year) in the area, but there
is some chance of rapid growth if the ski corporation decides to implement
business expansion plans. At some point in the future, the ski corporation
plans to expand capacity by adding additional ski lifts and snow making
equipment. The exact timing of the expansion is very uncertain.

The planners at Blue Mountains Power believe that some distribution ca-
pacity needs to be added very soon in order to respond to the planned
expansion of the local ski area. However the expansion of the ski area has
not yet begun. The ski area management claims that the first phase of their
plans would add about 8 MVA load and the second phase would add another
8 MVA. The exact timing of the planned expansion is very uncertain. The
question that planners face is when, if ever, will the expansion take place?

This Tutorial shows how to use the Load Assessor tool to address this ques-
tion. There are three steps:

1. Start the Load Assessor program and open a new input file.

2. Run the Load Assessor tool to create the input parameters for a fore-
cast.

3. Run LoadDynamicsTM and view the plotted output.

4.1 Step 1: Start Program and Open a New File

For step 1 the user should: (1) open the model by clicking START , (2) select
Programs, (3) highlight LoadDyanamics and click on the LoadDynamics
icon, (4) click OK on the start-up screen, and (5) use the File|New menu
to open a new data set. The program will open a new input file and display
the forecast list and the Data Input Screen. This is show in Figure 4-1.
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Figure 4-1: Tutorial Two: Start LoadDynamicsTM and Open a New Forecast
File

4.2 Step 2: Run the Load Assessor Tool

Note: the Load Assessor input screens are described in detail in Section 2.3.
The screens are not reproduced here except to show key input values and
outputs.

To run the Load Assessor tool, the user must click the button ASSESS
LOAD GROWTH PROBABILITIES on the Data Input Screen. This will
open the main Load Assessor screen. The user should then use the File|New
Load Assessor Data menu to open a new load assessor input file. The result
is shown in Figure 4-2.

The load assessor has four data screens and a calculation screen that contains
the resulting transition matrix. The input variables and associated study
assumptions are summarized in Table 4-1. Table 4-1 contains all of the data
necessary to fill-in Screens 1, 3, and 4. To input data for Screen 1, click
the Specify Current Load and Growth button. After entering the data on
each screen, click the → button to move to the next screen.
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Figure 4-2: Tutorial Two: Start Load Assessor and Open a New Assessor
File

Input Variable Study Assumption

Screen 1 Current Load 34,000 kVA
Current Growth Rate 0.5%
Forecast Period 12 Years

Screen 2 Load Growth Scenarios Avg. Growth Scenario 1: 0.5%
Avg. Growth Scenario 2: 1.0%

Load Jump Possibility: Yes
Proportion yrs. w/rapid growth: 0.1
Rapid growth rate (%): 12

Screen 3 Holding times Min. rate (0%): 4 years
Current rate (0.5.%): 4 years
Max. rate (1.5%): 2 years

Screen 4 Saturation 55,000 kVA
Saturation onset 40,000 kVA

Table 4-1: Summary of Load Assessor Data Screens
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4.2.1 Screen 1 - Current Load and Growth

Current peak load is 34,000 kVA and load is growing at about a half percent
per year. The period over which load is to be predicted is 12 years.

4.2.2 Screen 2 - Load Growth Scenarios

Up to five scenarios can be used to describe future business as usual load
growth behavior. These scenarios must be mutually exclusive descriptions
of what can happen, under normal conditions, to load over the planning
period. Each scenario must be described along four dimensions: the average
growth rate over the entire planning period, the lowest possible growth rate
in any year, the highest possible growth rate in any year, and the likelihood
of the scenario actually occurring. The sum of the likelihoods must be 1.0.

Two scenarios were used for this analysis: (1) the current slow load growth,
0.5 percent, continues through the planning period; (2) the current slow
growth doubles and the average over the period is 1.0 percent.

The business as usual scenarios do not reflect the possibility that the ski area
expansion occurs sometime during the planning period. This is modeled
using the load-jump feature. For this case the utility analysts expect that
there is about a one chance in ten over the next ten years that the first
phase of development will occur adding 8,000 kVA to existing load (about
12% of 34,000). If this occurs, they believe that there is about a one chance
in ten that the second phase of development will occur — adding another
8,000 kVA load. The model inputs for these assumption are:

1. the proportion of future years with rapid growth — about one in ten
for this case or 0.1,

2. the growth rate for the rapid growth periods — 12 percent.

Figure 4-3 shows the scenario input screen and related data. The user should
input the data to match the values shown in Figure 4-3.

4.2.3 Screen 3 - Growth Rate Holding Times

One of the underlying assumptions in the Load Assessor is that load growth
tends to persist and follow multi-year trends. These trends are represented
by assessing the likelihood of the persistence of the load growth rate in any

42



Figure 4-3: Tutorial Two: Load Assessor Scenario Inputs

year over the next several years. Screen 3 is used to record growth rate
duration information. The duration of a load growth rate is often referred
to as the holding time of the rate. Holding times must be provided for three
annual growth rates: minimum, maximum and current.

4.2.4 Screen 4 - Maximum Area Load

The maximum area load is estimated to be about 55,000 kVA. This is the
load level when the area is completely built-out. Saturation onset is the
point where load growth starts to slow due to build-out. For the study,
saturation onset is assumed to be 40,000 kVA.

4.2.5 Screen 5 - Transition Matrix

After the data are entered, the Load Assessor is run to generate the growth
trends and transition probabilities. After entering the data for Screens 1-
4, click on the → button to go to Screen 5. Then click the Estimate
parameters button to run the model and generate the growth trends and
transition probabilities. If one or more of the growth trends is greater than
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Figure 4-4: Tutorial Two: Estimated Growth Rates and Transition Proba-
bilities

20 percent, a dialog box informs the user of this and offers the options to
continue, Y es or No. If Y es is selected the model estimates the parameters.
If No is selected, the model is not run, and user can modify the input data
before continuing.

The transition matrix that results from the above inputs is shown in Fig-
ure 4-4. The growth rates and transition matrix that are found by the Load
Assessor comprise a mathematical representation of the input data captured
in the screens described above. The mathematical representation is selected
to minimize the error between the forecasts provided by the scenarios and
the forecasts provided by the mathematical representation.

The resulting forecast results can also be plotted by clicking the PlotResults
button. The result is shown by Figure 4-5.

Most users will find the information provided in the plot sufficient to de-
cide whether the load assessment captures the appropriate load uncertainty.
If the uncertainty has not been captured, the answers to the questions in
screens 1 through 4 can be changed, which will change the plotted results.
This modification process can be repeated until the results are satisfactory.

44



Figure 4-5: Tutorial Two: Plot of Load Forecast

After the user has input the Load Assessor data successfully and obtained
the results shown in Figure 4-4, they should click OK followed by the Home
button to return to the Load Assessor home screen. At this point they should
copy the results to the LoadDynamicsTM Data Input Screen by clicking the
button Copy Results to Growth Scenarios. Clicking this button will show
a dialog box to confirm if the results are to be copied and the assessor
exited. The user should click OK. If the current load assessor data have
not been saved, a dialog box will ask if the user wishes to save the data.
For this tutorial, the user can select either Y es or No (saving the data file
is not required by this tutorial). The estimated growth rates and transition
probabilities will be copied to the LoadDynamicsTM Data Input Screen.
Other required data will also be copied including starting load and growth,
the planning period, and the load saturation parameters. This is shown in
Figure 4-6.

4.3 Step 3: Run LoadDynamicsTM and View Plotted Output

The user should click on the Run menu. This will run the model. The
first model calculation is to estimate the load growth trends from the input
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Figure 4-6: Tutorial Two: Data Input Screen after Copying Load Assessor
Results

trends. Because one of the estimated trends is greater than 20 percent, a
dialog box is displayed indicating this fact and asking the user if they wish
to continue. The user should click Y es. The model will then complete
the run and display a dialog box indicating that the model has run. The
user should click the OK box and view the output using the Plot menu.
Figure 4-7 shows the results for selecting the Y ear vs. Load option.

Returning to the original question that planners face, when, if ever, will the
ski area expansion plans take place? Phase 1 expansion would add 8MVA
and Phase 2 another 8 MVA. To examine this question we can plot the
cumulative probability distribution of the time to reach 42 MVA and 50
MVA from the current 34 MVA load levels. This is plotted by clicking on
the Plotmenu and selecting CumulativeProbability. Then select load levels
41912.20 and 50144.33 from the dialog box and click PLOT . The result is
shown in Figure 4-8

These plots of the cumulative probability of the time required to reach the
two load levels demonstrate that:

The likelihood of reaching the load level represented by both phases of
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Figure 4-7: Tutorial Two: Plot of Year Versus Load

Figure 4-8: Tutorial Two: Cumulative Probability Distributions - Time to
Reach Load
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expansion is very unlikely. The probability that load will reach 50, 000
kVA by the end of the planning period is essentially zero.

The chances of just the first stage expansion (load reaching 42, 000
kVA) is higher. There is about a 25 to 30 percent chance that the first
stage expansion will have occurred by year 10.

To complete this Tutorial exit the program by selecting the F ile|Exit menu
option. The program will ask you if you want to save your inputs. If you
wish to do so, select OK.
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A ANALYTICAL METHODOLOGY

A.1 Model Logic

This section describes the logic that underlies the LoadDynamicsTM Model.
The purpose of this section is to 1) explain why this particular approach was
chosen, and 2) provide information that will help the user make informed
judgments when developing inputs and interpreting results.

A key observation that led to the modeling approach is that load is uncertain
but correlated over time; i.e., trends occur. The question is how to use this
observation when developing load projections. One approach would be to
project the current trend into the future. For example, suppose that area
load has followed a consistent growth trend for a few years, and we believe
that the trend will persist. In this situation, simple extrapolation could
be used to forecast the future. We could make the extrapolation more
sophisticated. For example we could guess about 1) when growth is likely
to transition to a new trend and 2) the level of the new trend.

However, there is a problem with extrapolations — they are like driving by
looking in the rear view mirror. At some point, the actual path that future
load follows will change. This change results in a very large number of
possible trajectories. Thus picking a load trajectory or two is not going to
provide a very good basis for evaluating how different investment strategies
might play out.

LoadDynamicsTM is based on the idea that it is useful to describe load
growth in terms of multiple trends that persist for uncertain durations. A
simple yet robust mathematical representation of such a phenomenon is a
Markov chain described by a transition matrix.3 The Markov representation
of the load trend idea is illustrated in Figure 1-1. The top half of the figure
shows a situation where, over time, load growth follows trends. Key ques-
tions are 1) how long does load follow a given trend, and when it transitions
to a new trend, 2) what is the level of the new trend. The bottom half of
the figure illustrates how transition probabilities provide answers to these
questions. Transition probabilities represent the uncertainty in the level of
the next trend and the uncertainty in the time to the next trend.

The interpretation for the situation shown in Figure 1-1 is the following.
There are three trend states. For the low trend state there is a probability

3For a discussion of Markov models see Howard R.A. 1960. Dynamic Programming
and Markov Processes. John Wiley, New York.
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Figure 1-1: The “Load Trend” Concept and its Representation as a Markov
Chain

of 0.9 that the trend will persist into next year, and a probability of 0.1 that
growth will transition to the medium trend. For the high growth trend, the
chance of staying in that high trend is 0.7 and the chance of shifting to the
medium trend is 0.3. For the medium trend there is a 0.8 chance that the
trend persists, a 0.1 chance that growth transitions to the high trend, and
a 0.1 chance that the transition is to the low trend.

This characterization of load trend uncertainties captures information on
the probability of transition to a new trend. It also represents the tendency
to stay in a given trend. For example, for the probabilities given above, the
average times that load growth will be in the low, nominal and high states
are 10, 5, and 313 years respectively:

Average T ime In Trend =
1

1− P (Staying in Same Trend)

LoadDynamicsTM is based on a Markov representation of load growth dy-
namics. Using his approach and given potential future growth trends, the
model generates all possible load trajectories. Based on the trajectories, it
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is straightforward to produce statistics on future load growth paths.

A.2 Comparison With Traditional Approaches

There are many possible approaches for developing forecasts of future load.
It is worth noting how LoadDynamicsTM differs from some of the more
traditional forecasting methods. A typical forecast is an extrapolation of
historical average growth. Variance in actual growth might be used to es-
timate the uncertainty. There are several problems with simple extrapola-
tions. First they do not provide information on potential load dynamics.
Extrapolation contains no specification of the timing or the likelihood of
transitions from the current growth path to possible alternative paths. As
a result, they do not provide information that can help planners identify
transitions or turning points.

Second, basing forecast uncertainty on the variance in historical growth
rates implicitly assumes that the variance in future load does not change
over time. The implicit assumption is that uncertainty does not change
over time and there is no ”learning by waiting.” This implicit assumption
is inconsistent with the fact that load growth can follow trends and that
the likelihood of specific future load conditions may depend on the current
conditions. For example the probability of shifting to a high growth rate
may be different depending on whether you are currently experiencing low
growth or moderate growth.

A third issue is with the way that historical trend statistics are typically
estimated. A standard technique is to estimate an average growth rate
by fitting a regression line through historical data. The slope of the line
represents average growth. The variance is estimated using the regression
residuals. The problems here are: 1) historically, load may have followed
several trend patterns for different periods of time (the regression line defines
the average trend), and 2) the curve fitting approach provides no information
on the duration of the various trends.

The fourth problem is with the use of the historical data. The past is not
necessarily representative of the future. This is especially true when esti-
mating future conditions for small areas. Growth trends are driven by real
events such as changes in zoning laws and shifts in the local economic con-
ditions. If the future is expected to be different than the past, the forecasts
should reflect potential future conditions.
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A.3 Model Structure

LoadDynamicsTM model and software uses a tree structure to characterize
possible load trajectories. In this section the tree representation is described.

To illustrate the tree representation, suppose the load uncertainty situation
is such that there are two trends, a nominal trend and a high trend. The
transition probabilities are given in Table 1-1.

To Nominal To High

From Nominal .8 .2

From High .4 .6

Table 1-1: Example 1: Transition Probabilities

This table shows that if the current load growth is nominal, the chance of
staying in that nominal trend is 0.8 and the chance of shifting to high is 0.2.
If the current growth trend is high, the chance of staying in the high trend
state is 0.6 and the chance of going to nominal is 0.4. Further, suppose that
at the start of the planning period, year = 0, load is 100 and the load growth
is in the nominal trend state.

For this example, we define the growth rates to be one percent and two
percent for the nominal and high trends respectively (α = .01 and β = .02).
Given these definitions, the load at the next time, t + 1, is given by the
expression:

loadt+1 = loadt(1 + trend growth rate)

Specifically, if the load growth rate is high, the load for the next period is:

loadt+1 = loadt(1 + β)

Figure 1-2 is a tree that describes some possible growth trajectories. For
simplicity, the figure covers the possible trajectories for only two years. This
set of assumptions produces four trajectories for the two year period.

The LoadDynamicsTM software develops a similar tree by creating a set of
nodes. Each node is characterized by the load level, the probability of that
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Figure 1-2: An Example of Possible Growth Trajectories
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load, the growth trend that produced the node, and the index of the node
that the node originated from. The collection of all nodes, with parent-child
or precedence relationships, describes all possible load growth trajectories.

A.4 Growth Trend Correlation and Load Uncertainty

In this section we provide an example to demonstrate that load growth
uncertainty is quite sensitive to the degree that loadt is correlated with
loadt+1, the existence of load growth trends.

Suppose that historical annual growth rates are observed and that half the
years have a nominal 1% growth rate and half the years have a high, 4%
growth rate. No attempt is made to measure directly the duration of these
trends. Instead, from this data, the inference is drawn that, in any year,
the load growth is equally likely to remain in the same trend or to make a
transition to the other possible trend. Given this inference, the transition
probabilities for any year are 50% of staying in the current trend and 50%
of shifting to a new trend. These probabilities are given in Table 1-2.

To Nominal To High

From Nominal .5 .5

From High .5 .5

Table 1-2: Example 2: Transition Probabilities

The difficulty with this approach is not enough information has been ob-
served to specify the transition probabilities. What has been observed is
the long term average for the chance of being in one of the two load states
in a given year. This is known as a steady-state probability distribution. In-
deed, this distribution can be derived from the transition probability matrix,
but the steady-state distribution is not sufficient to determine the matrix
(the relationship between the steady-state probability distribution and the
transition probability matrix will be described in a forthcoming technical
paper). In fact, for the two-state case, equal steady-state probabilities im-
ply only that the diagonal elements of the transition probability matrix are
equal. Thus, given the observation that growth rates tend to be in each
state half of the time, the transition matrix could also have the values in
Table 1-3.

The difference in load growth behavior implied by the two transition ma-

54



To Nominal To High

From Nominal .8 .2

From High .2 .8

Table 1-3: Example 3: Transition Probabilities

trices is in the expected duration of each trend state. In the first case, the
expected duration in each state is two years. In the second case, it is five
years. A consequence of this difference is that the variances in the load
forecasts produced by the two transition matrices are not the same. Indeed,
the variance in the first case is somewhat less than in the second case.

In general, correlation between growtht and growtht+1, rather than inde-
pendence, will yield larger variance in possible load over time. If correlation
is present, trend duration is a key parameter for developing probabilistic
forecasts of load conditions. To illustrate the effect, LoadDynamicsTM was
applied to two alternative sets of load growth transition probabilities. These
are described in Table 1-4.

NO CORR To Low To Nominal To High

From Low .25 .50 .25

From Nominal .25 .50 .25

From High .25 .50 .25

CORR To Low To Nominal To High

From Low .80 .20 0

From Nominal .10 .80 .10

From High 0 .20 .80

Table 1-4: Transition Probabilities for the “NO-CORR” and “CORR” Cases

In the “NO CORR” set there is no correlation between the growth states
in period t and period t+ 1. Specifically, the likelihood of the next periods
load growth rate does not depend on the current period’s growth rate — the
transition probabilities are the same for the low, nominal, and high trends.

In the second set of transition probabilities, there is strong correlation. For
example, if the growth rate is low, there is a much higher probability of
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Figure 1-3: An Example of The Effects of Correlation on Forecasted Load

staying in the low state rather than shifting to another state. The same is
true for the nominal and high growth states. In this example, load growth
persists in a state once it transitions to that state. Thus the growth rates
for periods t and periods t + 1 are correlated. Trends exist. The effect of
the correlation on forecasted load is plotted in Figure 1-3.

A.5 The Load Jump Method

A.5.1 The Basic Idea

The idea is simple. There is a chance that for any year the system will enter
a load jump state. Let the chance of being in the jump state be represented
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by probability p. We separate growth states into normal or business as usual
and jump. Under these assumptions, the transition matrix can be partioned
into four components.

T =

∙
P11 P12
P21 P22

¸

The upper block of T represents the transition probabilities for the business
as usual growth states. P11 is an n x n matrix that specifies the transition
probabilities among the business as usual growth trends. P12 is a column
vector each of whose elements is the probability that a jump transition
occurs from any business as usual growth state. See assumption 1, below.
The lower block of T , [P21P22], is an n+ 1 vector of transition probabilities
for the jump growth trend. The scalar P22 is the probability that a jump is
followed by another jump. See assumption 2, below.

A.5.2 Implementation

Given an n x n business as usual transition matrix, the only other required
data is the probability that a jump occurs, conditional on the current state.
We interpret this as the steady-state probability, p, that the load growth is
found in the jump state. That is an approximation. The augmented matrix
T is specified by the following four assumptions.

1. Leakage from any state to jump is constant.

2. Transitions among normal or business as usual, BAU, growth rates
are proportional to their original values.

3. A jump cannot transition to itself, and the transitions out of the jump
state are given by the BAU steady-state probabilities.

4. The steady-state probability of being in the jump state is given, p.

Thus for the matrix T , above, it can be shown that P12 is a vector of n
elements equal to

p

1− p.
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P22 is zero by the assumption that a jump cannot transition to itself. P11 is
obtained by multiplying the BAU matrix by the scalar

1− 2p
1− p .

Scalar multiplication follows from the assumption that transitions among
BAU growth rates are proportional to their original values. Finally it can
be shown that the elements of P21 are obtained by multiplying the steady-
state probabilities given by the BAU matrix by 1− p.

A.5.3 Details

This is not a proof of the validity of the implementation. The purpose is to
provide some of the details behind the assumptions.

If the above transition matrix is rewritten as

T =

∙
P q1
π0 0

¸
where π0 is the steady-state probability vector given by the BAU matrix,
q is a scalar and 1 is an n-vector each of whose components is unity, then
the steady state transition probabilities, π1 and p, can be found from the
equations:

π1P + pπ0 = π1

qπ11 + 0p = p

π11 + p = 1.

From these equations (recall that p is given) q = p/(1− p). Each element of
the vector q1 is the leakage from the BAU matrix that is the result of the
potential for a load jump. Further, P = (1− q)BAU and π1 = (1− p)π0.
This completes the Analytical Methodology appendix.
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